ClearClick® 720p/1080p_
HD Video Capture Stick "

Full 1-Year Warranty &
Free USA-Based Tech Support

This product comes with ClearClick®'s full 1-year warranty & free
USA-based tech support. As a small business, we’re here to serve you!
If you have any issues with our product, please contact us at
support@clearclick.tech.
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Register Your Device & Browse Our Products

Thank you for your purchase! Make sure you register your product &
check out our other unique & easy-to-use technology at:
www.ClearClick.tech

Full 1-Year Warranty & Free USA Tech Support

We're ClearClick®, a small business based in California. We try to provide
the best experience possible with our products.

We provide free USA-based tech support for our products. All of our
products also come with a full 1-year warranty. If you need any assistance
with this product, please email us at support@clearclick.tech.

Safety & Legal Warnings

1. Do not disassemble the unit.

2. Do not operate the unit around water or rain.

3. Do not operate the unit around any kind of machines (other than
your video source).

4. Unplug and safely store the device when not in use.

5. ltis your responsibility to respect all copyright laws in your
country.
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What’s In The Box?
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a. HD Video Capture Stick™ b. HDMI Cable c. Micro USB Cable
d. User’s Manual e. Software/Driver CD  f. USB To Type C Adapter
(for Mac)

Part missing or broken? Please email us at parts@clearclick.tech
and we’ll be happy to help you out!
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QU ick Start Guide — Windows (Mac Users: See Page 14)
1. Install Software & Drivers

Insert the CD into your computer and run the Windows setup file.
Install the DXPlayer software. If your computer doesn’t have a CD
drive, please contact us at support@clearclick.tech for a download link
for the software & drivers.

Welcome to the DXPlayer Setup
Wizard

Windowns Driver &
DXPlayer,

This wil install DXPlayer V130 Buid 109 on your computer.

kis
continuing.

you close all

Click Neat to continue. or Cancel to exit Setup.

User Manual

Browse this CD

Continue through the installation. The DXPlayer setup program will
automatically install the drivers for the HD Video Capture Stick™.

If you receive the “Windows Security” message as shown on the next
page, click the “Install” button.
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=] Windows Security

Would you like to install this device software?

Mame: eMPIA Technolegy Seund, video and game ...
Publisher: eMPIA Technology Corp.

*)

Always trust software from "eMPIA Technology Install Don't Install
Corp.".

@) Vou should only install driver software from publishers you trust. How can | decide which
device software is safe to install?

2. Plug In Your HD Video Capture Stick™

@O @

Locate the included micro USB cable and plug the small end of it into
5



the HD Video Capture Stick™ (see [1] in diagram on previous page).
Plug the other end of the cable into your computer.

Next, connect your HDMI video source to the HDMI port on the HD
Video Capture Stick™ (see [2] in diagram on previous page).

An example of what your setup could look like:

’ J.g

DVD Player




3. Open & Register DXPlayer Software

Run the DXPlayer software on your computer:

When you first run the Register (AF54C63C)
SOftware, DXPlayer WI” Make sure your computer is connected to the
I . Th i i de,
prompt you to register the i e e
SOftWare usi ng youl’ name, label on the endosure of the device. Please fill
. . . in your real name and proper Email address,
emal I, and regIStratlon code. which will be used for after-sales service.

(We recommend doing this
immediately, because
without registering the
software, the recording time
is limited to 10 minutes.)

(2g: DADXXX-XXX-XXXXXX-XXHHXX-XXXXXX)

Your registration code is
located on the back of the
CD envelope.

OK Cancel




4. Start Recording Video!

If a live signal is coming from your HDMI video source, you will see a
live video preview in the DXPlayer software.




button.

To stop recording, click the stop button. H

To pause recording, click the pause n button.

To capture a frame (take a still photo) of your video,
press the screenshot button.

To start recording, click the record




To play back recorded clips, first press the folder icon at
the bottom of the screen.

Then press the play button next to the file you'd like to

Or to open the folder that contains the clip, press the
folder button next to the clip’s name.

Videos Images
Video Image
File Info

VID_20170625_20.32.30.mp4 72.28MB,00:01:22
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To schedule recording for a certain time, use the “Schedule
Recording” feature. (Accessible through the settings section.) You can
have the software start recording at a certain time for a set amount of
time. You may have the software do this once or repeat every day.

Schedule Recording

[W Enable Schedule Recording

© Every day

Timer 1: Start time | | recording | minutes

Timer 2: Start time 77777 I recording | | minutes

Timer 3: Start time | recording 777 minutes

Timer 4: Start time :V I recording ; | minutes

(Please set time at 24h format,eq: 19:30)
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In the “Setup” window, you can adjust various settings for the
DXPlayer software. For an explanation of all the settings, please see
the next page.

Video Resolution:
Video Bitrate:
A/CEVRELT el Video Mixing Render9
PG Gl il SYstem DirectSound
Recorded Audio Format C
Hotkey for Recording: 3]
GEIG LRV  CISl MP4 (MPEG-4)

Language: fl|E]

Video Files Saved To Folder: } C:\Users\Test_A\Videos

[fd Auto generate file name when recording.

[ Show recording info when in full screen.

Set up maximum record time: m hour(s) m minute(s)

(Select "0" for unlimited record time)
Schedule Recording

oK




Video Resolution: Sets the recording resolution. 1080p, 720p and 480p are
available.

Video Bitrate: Sets the quality of recording. High, Mid, Low are available.
Video Render: Sets the video rendering technology. Video Mix Render9 and
Internal YUV Render are available.

Audio Render: Sets the audio rendering technology. System DirectSound and
Internal Audio Render are available.

Recorded Audio Format: Sets the audio format. MP4 (MPEG-4) / MP4
(MPEG-TS) are available.

Hotkey for Recording: Sets the hotkey for starting and stopping recording of
video.

Recorded Video Format: Sets the video format.

Language: Sets the language to be displayed on the screen. English,
Japanese, Simplified Chinese and Traditional Chinese are available.

Video Files Saved to Folder: Sets the directory that recorded videos will be
saved in. You can change the directory by clicking on the folder button.
Automatically generate the file name when recording starts: If this option
is selected, the filenames of recorded videos will be set automatically.

Set up maximum recording time: Sets the maximum recording time.
DXPlayer will stop recording when the maximum recording time is reached.
Schedule Recording: Allow you to schedule recording in advance.

OK: Click to save the settings.

Cancel: Click to exit the "Setup" window without saving the settings.
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Quick Start Guide — Macintosh
1. Install Software & Drivers

Insert the installation CD into your Mac. (If your Mac doesn’t have a CD drive,
please contact us at support@clearclick.tech for a download link.)

Browse the CD contents and double-click the “MAC-Driver.pkg” file. The
installation window will open. Continue through the installation to install the
driver. Then restart your Mac.

)  Install Empia Capture Device el |® w Instali Empia Capture Device -
Weicome to the Empia Capture Device Installer The installation was completed successfully.
your Empra Technoiogy viceo capture « Introduction
dovee
« Destination Select
* Instaliation Type
» Installation *
« Summary The installation was successful.
The software was installed.
Click Restart to finish installing the software.
Continue m
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2. Plug In Your HD Video Capture Stick™

@ @

Locate the included micro USB cable and plug the small end of it into
the HD Video Capture Stick™ (see [1] in diagram above). Plug the
other end of the cable into your computer.

Next, connect your HDMI video source to the HDMI port on the HD
Video Capture Stick™ (see [2] in diagram above).
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An example of what your setup could look like:

)\

‘.“ DVD Player \

e ——— I“
=)= ———7 @/
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3. Open QuickTime Player

Open the QuickTime Player software on your Mac.

Click File > New Movie Recording.

@ QuickTime Player Edit View Window Help

. New Movie Recording 3N
¥ New Audio Recording ~"\X 3N
New Screen Recording ~8N

Open File... 380
Open Location...
Open Recent

Close

Save...

Duplicate
Rename...
Move To...

Export
Revert To
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Click the arrow next to the “Record” button.

Make sure both the “Camera” and “Microphone” are set to: “HD Video
Capture Device.”

For quality, make sure “High” is selected. (Note: selecting “Maximum”
will result in very large video files, due to uncompressed video)

Make sure the volume is turned up part way.

v HD Video Capture Device

v HD Video Capture Device

High
v Maximum
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4, Start Recording Video!

If a live signal is coming from your HDMI video source, you will see a
live video preview in the DXPlayer software.

Simply press the “Record” button to start recording
video.

When you are done recording, press the “Stop” button.

Your video file will be saved in MOV format in your Videos or
Documents folder.
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Live Streaming with XSplit Software on PC

You can use the HD Video Capture Stick™ to stream your HDMI video
source (such as a video camera or gaming device) over the internet.
To do this, you will need the XSplit Broadcaster or OBS streaming
software. (Not included) Here’s how to get started.

1. Download the XSplit Broadcaster software from www.XSplit.com
and install it.

2. Open the XSplit Broadcaster software and click Add - Devices
(Webcam, Capture Card) - Video - HD Video Capture Device.

.-III|||“ $ .-llllllll o || Transiton | Fad

e Scene 1

Screen capture...

Game capture »

Devices (webcam, capture cards...)  » i Video » | HD Video Capture Device
Text... Audio null

Webpage... .

Media file (videos, images)...

20
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3. Click Settings. Under Audio Input, select “HD Audio Device.”

S contllll & _cstll] 4 o

HD Video Capture Device

Add » Copy Paste Remove Rename Seftings

HD Video Capture Device Sticky »

Cam
G Refresh

DR || b

Audio Input HD Audio Device

Audio Output  System Sound

Offset (ms)

HD Video Capture Device

1353 MB




4. Click Outputs = Set up a new output = (Choose a website)

o Outputs 0 00 p
) LocalRecording Fo3
¥ Newtek NDI™ Output  (3)
Projector 4
S | Set up a new output » l @ Twitch
- Remove output B YouTubelive
‘ ‘\ p , ; “ Facebook Live
24 ; I ; = .§ 3 oot \ @ Beam
i h \ - [0 Ustream
L= W e m Dailymotion
/ \ &y FC2Live
i S J (% Azubu
— £ - 2 Custom RTMP
%L Local Streaming
Hitbox
Get more outputs...
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5. Enter your username and password for the selected website or
social network (you will need an account set up with the website
already).

m not a robot
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Credent oV
oS Sl ClearClick123
lomatic A Test bandwidth

I Confirm ingest server before broadcasting

525 | defauk defauk no data a

o

Note: Some encoding settings may be disabled for compatibiity with Twitch

B Automatically save recording on local drive
M Enable Stream Delay - seconds

Setup wizard

24



Atternpting to stream to Asia: Taipei, Taiwan
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6. After the setup is completed, click Outputs - Twitch (or other site)
- ClearClick123 (your account name) to start streaming.

=

File Sources | tputs Extensions Tools ma Help

Twitch - ClearClick123 %3¢
Local Recording £O 3

Newtek NOI™ Output (D

Projector >

Add ~ Copy Paste Remove Settings

95% /85% / 21GHz
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Live Streaming with OBS Software on PC or Mac

1. Download the latest version of OBS software from
www.obsproject.com and install it. The software is compatible with

Windows, Macintosh, and Linux.

2. Open the OBS software and click the “Settings” button.

(5 08S 17.0.0 (windows)

File Edit View Profile Scene Collection Tools Help

Scenes Sources oer K3 Scene Trnsitons |
[Scen ‘Desiaop Audio 00¢8 ~| [Fade i ]
o % +— 0 ]

/A, 00é8 | puration 300ms (2 [ il

| o e

el T—RAv - Ext J

00:00:00 CPU: 4.7%, 30.00 fps.
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3. Click “Stream® — Set your desired “Service” (streaming website) —
Enter your Stream Key — Click "OK.”

2 General Stream Type [5“3"‘?\9 Services v ]
@ Stream A Service [Twihch .]
["] show all services

@ Output Server IUS West: San Frandisco, CA X; ]

Stream key Show
4

(To find your streaming key, go to your streaming service’s website
and look in the settings. For example, on Twitch, click Dashboard,
Settings, Show Key.)

@

(]
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4. Click Sources — Add — Select Video Capture Device — Device —
Select “HD Video Capture Device.”

Edit View Profile Scene Collection Tools Help

Scene Transitions
|Scene | Mt ) 10068 | [Fade
‘ o8l + -
Deskop Audo 0.0d8 | = | puration 300ms
‘ (o %
F=av b= Biay  [eommom we |
00:00:00 «
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Device |HD Video Capture Device z
| Deactivate |
Zg:onﬁgue Video
[Configure Crossbar|

[] Deactivate when not showing

on/FPS Type | Device Default v

5. In the settings, under “Audio Output Mode,” select “Output desktop
audio (DirectSound)” and click OK.

FPS |Match Output FPS -
Video Format | Any -
YUV Color Space [Default ¥
YUV Color Range [Partial = '
Buffering [Auto-Detect ¥ !
A [ =] Fiip Vertically -
Audio Output Mode fawtmmmrmm) ~|
] Use custom audio device 8 -
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6. Click the “ Start Streaming ” button.

Profile

Scene Collection Tools Help

Scenes Sources vixer K Scene Transitions
Scene © Video Capture Device | | Video Coprure Device as1de ~| [cut ) (| stertstreaming |
{1 (VR -3 + — & Start Recording
] o - —
t=iav t—einv || ="

00:00:00 CPU: 9.6%, 30.00 fps
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Need help?

Open a support ticket and we’ll get back to you
within 24-48 hours! (Monday-Friday) Just visit:

http://Support.ClearClickSoftware.com

or email us at:

support@clearclick.tech

&(lilearuick“

www.ClearClick.tech
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